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Introducing the Excel 

Presentation Kit 

Thanks for purchasing the Excel Presentation Kit, a tool I designed to enable 

Excel 2007 users to create persuasive, data-driven presentations from within the 

comfortable confines of Excel. 

In this chapter, I’ll discuss my goals for the Excel Presentation Kit, provide an 

overview of how the Excel Presentation Kit works, describe the new features in 

Excel 2007, lay out what I assumed about my typical reader, and refer you to other 

books to flesh out the instructions found in this manual. 

Goal of the Excel Presentation Kit 

My goal in creating the Excel Presentation Kit is to enable you to deliver 

effective business presentations without leaving Excel and without fumbling through 

your notes to remember how to create a particular workbook configuration.  

PowerPoint is a wonderful tool for text- and graphics-based presentations. And, 

yes, you can even embed Excel workbooks in a PowerPoint slide, but if you want to 

work with the data you’re still faced with the unenviable task of manipulating a 

workbook while you’re sweating in front of your bosses. And their bosses. 

The Excel Presentation Kit lets you to record an Excel Presentation that removes 

much of the uncertainty and potential slips from your work. You’re working in a live 

Excel workbook, so you can always break away from your script, manipulate your 

workbook, and return to the script as if nothing happened. 
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How the Excel Presentation Kit Works 

Excel Presentations are based on positions you record using automated routines 

(macros) that I built into the Excel Presentation Kit template. The following image 

represents a workbook configuration you could record as an Excel Presentation 

position. 

 

Here’s how the Excel Presentation Kit stores that position in a table on the 

workbook’s Positions worksheet. 

 

The basic idea is that you create and record workbook positions, arrange those 

positions into a script, and move through the Excel Presentation script one position 

at a time. Here’s what a simple Excel Presentation script might look like. 

 

You can move forward and backward through your Excel Presentation, 

manipulate your workbook without calling the next position, and even switch to 
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other programs without dropping out of Slide Show mode as you must do when 

you’re running a PowerPoint presentation. 

What’s New in Excel 2007 

The most noticeable new aspect of Excel 2007 is the user interface. Officially 

named the Microsoft Office Fluent user interface, but commonly called the Ribbon, 

the new user interface is designed to make the capabilities of Excel, Word, and 

PowerPoint more discoverable for the average user. 

 

For the most part, the Ribbon meets that goal by bringing many more Excel 

capabilities to the top level of the user interface. Yes, it does take time to figure out 

where some things are. For example, you get at saving, printing, and similar 

features by clicking the Office Button at the top left corner of the program window. 

 

One negative aspect of the new user interface is that users have lost the ability 

to create custom toolbars that you can move around the program window. You can 

still create custom menus groups on the Ribbon, and add buttons to the Quick 

Access Toolbar (found beside the Office Button), so some of the previous 

functionality is still there. 

If you’ve installed an add-in, such as Solver or a third-party solution, you’ll find 

those items by clicking the Add-Ins tab on the Ribbon. 

In addition to the Ribbon, Office 2007 comes with new conditional formatting, 

graphics, charting, and drawing capabilities. That’s right, the 56-color limit of Excel 

97-2003 restricts you no longer! 
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Finally, Excel 2007 uses a new file format that’s based on the Microsoft Open 

Office XML (OOXML) standard. The Excel Presentation Kit is a macro-enabled 

workbook template, a new file type in Excel 2007, so you must use the kit with 

Excel 2007 or later. 

What I Assume about You, the Reader 

The Excel Presentation Kit uses macros to record basic and not-so-basic Excel 

2007 workbook configurations, so I assumed that the typical reader is an 

intermediate or advanced Excel user. That means you should know how to enter 

data, save files, create formulas, format cells, create charts and graphs, and sort 

and filter data. More advanced users will be familiar with conditional formats, 

PivotTables, and scenarios. 

Because I assumed a fair bit of knowledge from you, the reader, I felt 

comfortable ending some of the procedures in Chapter 3 end with steps such as: 

4. Use the controls in the dialog box to define your conditional format. 

Even if you’ve never created a conditional format in your life, you’ll be able to 

read the write-up in the section above the procedure to get help on what you need 

to do. The same is true for the other procedures in Chapter 3. 

Further Reading 

This documentation covers everything you need to know to build workbook 

positions, record those positions, and replay the recorded steps as part of an Excel 
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Presentation. I didn’t go into detail on techniques that weren’t directly related to 

creating recordable workbook positions, but there are lots of great books available 

that cover a wide range of useful Excel 2007 skills. I happen to have written several 

of them:  

• Microsoft Office Excel 2007 Step By Step, from Microsoft Press 

• Microsoft Office Excel 2007 Plain & Simple, from Microsoft Press 

• Excel 2007 Pocket Guide, from O’Reilly Media 

I also highly recommend several other books that will help you use and program 

Excel 2007 to meet your business needs: 

• Dashboard Reporting With Excel, by Charley Kyd, available directly from 

Charley through his website at http://www.exceluser.com 

• RibbonX: Customizing the Office 2007 Ribbon, by Robert Martin, Ken Puls, 

and Teresa Hennig 

•  Excel 2007 VBA Programmer's Reference, by John Green, Stephen 

Bullen, Rob Bovey, and Michael Alexander   
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2 

Creating Excel Presentation 

Content 

A presentation is only as good as the content it contains. Once you get your 

data into an Excel 2007 workbook, you can apply formats, limit data using filters, 

and summarize your data dynamically in PivotTables. 

This chapter details the procedures you’ll use to create the Excel 2007 workbook 

elements you record as positions for an Excel Presentation.  

Worksheet Tasks 

Excel 2007 worksheets are the largest unit of organization within a workbook. 

By default, Excel workbooks come with three worksheets: Sheet1, Sheet2, and 

Sheet3. 

You should think of a worksheet as a container for data on a given subject, such 

as sales, a project budget, or visitors to a facility. Attempting to combine too much 

data onto a single worksheet leads to confusion, so be sure to create a new 

worksheet whenever you want to store data on a new subject. 

In this section, you will learn how to: 

• Create a new worksheet. 

• Rename a worksheet. 

• Delete a worksheet. 

• Change a worksheet’s zoom level. 
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Creating a New Worksheet 

The Excel Presentation Kit template comes with three standard worksheets and 

two pre-formatted worksheets named Positions and Control. You use these two  to 

record and manage your presentation positions. If you need more than three 

worksheets to record your data, PivotTables, and so on, you can create more as 

required. 

To create a new worksheet: 

• On the tab bar, click the Insert Worksheet button (or press Shift+F11.)  

To create a new worksheet based on a worksheet template: 

1. Right-click the sheet tab of any worksheet and click Insert. 

2.  In the Insert dialog box, click the Spreadsheet Solutions tab. 

3.  Click the type of worksheet you want to add to your workbook. 

4.  Click OK. 

Note 

To find more templates online, click the Templates on Office Online button. 

Renaming a Worksheet 

Excel 2007 worksheets come with default names such as Sheet1, Sheet2, and 

Sheet3. Those names don’t help you remember which worksheet contains 

production data for your Philadelphia factory, so you should change the worksheets’ 

names to reflect the data they contain. 

Be Careful! 

The Excel Presentation Kit template comes with five worksheets: Sheet1, 

Sheet2, Sheet3, Positions, and Control. Renaming one or both of the 

Positions and Control worksheets will cause the template’s macros to fail, so 

don’t do it! 

To rename a worksheet: 

1. Right-click the sheet tab of the worksheet you want to rename. 
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2. Click Rename. 

3. Type a new name for the worksheet, and press Enter. 

Deleting a Worksheet 

When you’re done using the data on a worksheet, you can delete the worksheet 

quickly. Be aware, though, that you can’t bring a worksheet back after you delete 

it. 

Be Careful! 

Be sure not to delete the Positions or Control worksheets. If you do, the 

Excel Presentation Kit’s macros will fail. 

To delete a worksheet: 

1. Right-click the sheet tab of the worksheet you want to delete. 

2.  Click Delete. 

Changing Worksheet Zoom Level 

Excel 2007 is designed to be displayed on monitors at a resolution of 1024 x 768 

pixels. The standard cell and font sizes make worksheet data easy to read up close, 

but if you’re a few feet from the monitor, or in the back of a conference room 

where someone is giving a presentation, a worksheet’s contents can be very hard 

to read.  

If you want to focus on a set of cells, or just make the worksheet’s contents 

larger on the screen without changing the font size, you can change the 

worksheet’s zoom level. Increasing the zoom level from the default 100% makes 

the worksheet’s contents larger; decreasing the zoom level makes the contents 

smaller. 

One way to control a worksheet’s zoom level is by using the Zoom controls at 

the bottom right corner of the Excel program window.  
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You can also display the View tab of the Ribbon and use the controls in the 

Zoom group to set more precise zoom levels or zoom to a selection. 

 

Please Note 

The maximum zoom level is 400%; the minimum is 10%. 

To zoom in or out of a worksheet: 

• Click the Zoom In button to increase magnification by 10%. 

• Click the Zoom Out button to decrease magnification by 10%. 

• Drag the Zoom slider control to set a magnification level quickly. 

Excel Table Tasks 

Excel Tables, which are new in Excel 2007, are structured collections of data 

that have a defined number of columns and rows. Each table column has a column 

header, whether defined by you or assigned by Excel when you create the table, 

and the table’s rows and columns can be added and deleted without getting rid of 

the table. 

Excel Tables are excellent data sources for PivotTables, charts, and other data-

drive Excel 2007 objects. Unlike regular cell ranges, objects based on Excel Tables 

will update their data when you add data to the table (in most cases), when you re-

open the workbook after saving your changes and closing the workbook (in most 

other cases), or when you refresh the data from within the program (in the case of 

PivotTables). 

In this section, you will learn how to: 

• Create an Excel Table 

• Display an Excel Table Total Row 

• Filter an Excel Table by rule 
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• Filter an Excel Table by selection 

• Filter a Table to display above or below average values 

• Filter a Table to display the top or bottom values 

• Clear an Excel Table filter 

Creating an Excel Table 

When you’re ready to create a table based on an existing data list, be sure your 

list has column headings and that there is no data in the column to the left or right 

of your list data. If there is, Excel 2007 will include those columns in the table. Yes, 

you can delete those columns if they’re included, but it’s better to create the table 

correctly in the first place. 

To create an Excel Table: 

1. Define a data list with column headers and at least one row of data. 

2. Click any cell in the list. 

3. On the Home tab of the Ribbon, in the Styles group, click Format as Table. 

4. Select your desired table style. 

5.  In the Format as Table dialog box, check the My table has headers box. 

6.  Click OK. 

Displaying an Excel Table Total Row 

If your Excel Table contains numerical data, you can summarize that data within 

the body of the table by displaying the table’s Total Row.  



 

curt@thatexcelguy.com 11 
 

 

When you click a cell in a table’s Total Row, you can click the down arrow that 

appears and select which function you want to use to summarize the data in that 

cell’s column. The formulas that appear between the None and More Functions 

items correspond to the SUBTOTAL function’s arguments. In Excel 2007, these 

functions summarize the visible values only; in Excel 2003 lists, the functions 

summarized all values in the column. 

To display the Total Row of an Excel Table: 

1. Click any cell in the Excel Table. 

2.  If necessary, on the Ribbon, click the Design contextual tab. 

3.  In the Table Style Options group, check the Total Row box. 

Please Note 

To hide an Excel Table’s Total Row, uncheck the Total Row box. 
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Filtering a Table by Rule 

You can limit the data that appears in an Excel Table by applying a filter to one 

or more columns. Many filters can be stated as a rule: all values less than 100,000, 

all values between 100 and 200, all values greater than 50, and so on. To create a 

rule-based filter, click the filter arrow at the right edge of the column by which you 

want to filter the table, click Number Filters, and then click the type of filter you 

want to create. 

To filter an Excel Table by rule: 

1. Click any cell in the table. 

2.  Click the filter arrow of the column header representing the field by which 

you want to filter the table. 

3.  Point to Number Filters, and then click one of these filter options: Equals, 

Does Not Equal, Greater Than, Greater Than Or Equal To, Less Than, Less 

Than Or Equal To, or Between. 

4.  Specify the criteria in the dialog box that appears. 

5.  Click OK. 

Filtering a Table by Selection 

Not all data sets lend themselves to being filtered by rule. When you examine 

international sales data, for example, it’s often most useful to select individual 

countries from the list of values displayed in the table column.  

Please Note 

This version of the Excel Presentation Kit can only record selection filters with 

one or two items selected. 

To filter an Excel Table by selection: 

1. Click any cell in the table. 

2.  Click the filter arrow of the column header representing the field by which 

you want to filter the table. 
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3.  Uncheck the Select All check box. 

4.  Check the one or two boxes that represent the items you want to display. 

5.  Click OK. 

Filtering a Table to Display Above or Below Average Values 

When you examine data stored in an Excel Table, you can filter a value column 

to display rows where the value is either above or below average. Discovering 

which sales representatives have below average closing rates, for example, could 

help you choose who to offer selected training on that important skill. 

To filter an Excel Table to display above or below average values: 

1. Click any cell in the table. 

2.  Click the filter arrow of the column header representing the field by which 

you want to filter the table. 

3.  Point to Number Filters, and then click either Above Average or below 

Average. 

Filtering a Table to Display the Top or Bottom Values 

Successful business analysis often entails discovering your best and worst 

performers. You can display just the top or bottom values in an Excel Table column 

by creating a Top 10 filter.  

To filter an Excel Table to display the top or bottom values in a table column: 

1. Click any cell in the table. 

2.  Click the filter arrow of the column header representing the field by which 

you want to filter the table. 

3.  Point to Number Filters, and then click Top 10. 

4.  Use the controls in the Top 10 AutoFilter dialog box to set whether you want 

to show the top or bottom values, how many items to display, and whether 

the number you set represents the number or percentage of items to display 

(e.g., the top five items, or the top 5% of all items.) 
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5. Click OK. 

Clearing an Excel Table Filter 

After you’ve focused the data in an Excel Table using a filter, you can remove 

the filter to display all of the table’s data rows. 

To clear an Excel Table filter: 

1. Click the filter arrow of a filtered Excel Table column. 

2.  Click “Clear Filter from Field.” 

Conditional Formatting Tasks 

As the name implies, conditional formats change the appearance of a cell based 

on the cell’s value. Excel 2007 comes with a set of conditional formats you can 

apply but, with the exception of the Icon Sets conditional format, you can bypass 

the pre-defined conditional format color schemes and define your own format.  

When you apply a conditional format to a range of cells, be sure that every cell 

contains comparable data so the formats reflect the cells’ relative values accurately. 

For example, if your worksheet contains a cell that calculates the sum of sales for a 

month, the value that cell contains will be much larger than the values that record 

daily sales. Including the total cell in the conditional format range would make the 

daily sales values extremely low by comparison and render the formatting 

irrelevant. 

In this section, you will learn how to: 

• Create a Highlight Cells conditional format. 

• Create a Top 10 conditional format. 

• Create a Data Bar conditional format. 

• Create a Color Scale conditional format. 

• Create an Icon Set conditional format. 

• Clear a conditional format. 
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Creating a Highlight Cells Conditional Format 

Highlight Cells conditional formats enable you to highlight cells that contain 

values which meet a given criteria. For example, you could highlight cells that 

contain above- or below-average values, all values greater than 100,000, and so 

on. 

To create a Highlight Cells conditional format: 

1.  Select the cells to which you want to apply the format. 

2.  On the Home tab of the Ribbon, in the Styles group, click Conditional 

Formatting. 

3.  Point to Highlight Cells Rules. 

4.  Select the type of rule you want to create. 

5.  Use the dialog box that appears to set the parameters of your rule. 

 

6.  Click the right field’s down arrow, and either select an existing format or click 

Custom Format. 

7.  If you clicked Custom Format, use the controls in the Format Cells dialog box 

to define the conditional format you want the rule to apply. 

Creating a Top 10 Conditional Format 

The rule of thumb in many businesses is that 80% of your revenue comes from 

20% of your customers. Even though that summary isn’t always true, it is usually 

true that a small subset of customers generate the most revenue for a company. 

You can identify the top (or bottom) representatives of a list (months, products, 

customers, sales people, etc.) by applying a Top 10 conditional format to the 

worksheet column that contains the relevant data. 
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To create a Top 10 conditional format: 

1. Select the cells to which you want to apply the format. 

2.  On the Home tab of the Ribbon, in the Styles group, click Conditional 

Formatting. 

3.  Point to Top/Bottom Rules, and then click the type of rule you want to create. 

 

4.  In the dialog box that appears, set the number (or percentage) of items you 

want to be formatted. 

5.  Click the Format field’s down arrow to select the format you want to apply, or 

click Custom Format to define your own. 

6.  Click OK. 

Creating a Data Bar Conditional Format 

Analyzing data often involves comparing numbers to determine their relative 

values. You can look at the values themselves, but Excel 2007also enables you to 

create a data bar conditional format, which fills the formatted cells with color bars. 

The size of the bar reflects the relative size of a cell’s value as compared to other 

values in the same range, making it easy to compare cell values visually. 
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To create a Data Bar conditional format: 

1. Select the cells to which you want to apply the format. 

2.  On the Home tab of the Ribbon, in the Styles group, click Conditional 

Formatting. 

3.  Point to Data Bars. 

4.  Click the color you want to apply to the Data Bars. 

Note 

If you would rather make your data bars a color other than one of the six pre-

defined colors, click More Rules to display the New Formatting Rule dialog box. In 

that dialog box, click the Bar Color list box’s down arrow and use the color picker to 

select the color you want to apply. 

Creating a Color Scale Conditional Format 

Color scale conditional formats, often called “heat maps”, use color to indicate 

where values fall relative to the highest and lowest values in a range. For example, 

you could use a green-to-red color scale to indicate on which day of the week a 
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health care answer line receives the most calls (white indicates the lower values, 

and red the higher). 

 

To create a Color Scale conditional format: 

1. Select the cells to which you want to apply the format. 

2.  On the Home tab of the Ribbon, in the Styles group, click Conditional 

Formatting. 

3.  Point to Color Scale. 

4.  Click the color scale you want to apply to your data. 

Note 

If you would rather apply a color scale other than one of the eight pre-defined 

choices, click More Rules to display the New Formatting Rule dialog box. In that 

dialog box, select the Format Style (two- or three-color scale), and then click the 

Color list boxes’ down arrow to display a color picker from which to select the color 

you want to apply. 
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Creating an Icon Set Conditional Format 

Scorecard-based monitoring systems, such as the Balanced Scorecard approach, 

have become very popular. The hallmark of such approaches is to create a 

dashboard that summarizes how a business is performing relative to its goals. 

Every relevant measure has an easily-identifiable icon next to it so the decision-

maker can tell at a glance whether a factor is within the expected tolerances. 

 

To create an Icon Set conditional format: 

1. Select the cells to which you want to apply the format. 

2.  On the Home tab of the Ribbon, in the Styles group, click Conditional 

Formatting. 

3.  Point to Icon Sets. 

4.  Click More Rules. 

5.  In the New Formatting Rule dialog box, click the Icon Style list box’s down 

arrow and select the icon set you want to use. 
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6. Using the controls in the Display each icon according to these rules section of 

the dialog box, set the values for each icon. 

7.  Click OK. 

Please Note 

You can check the Reverse Icon Order box if you want lower values to be 

more desirable than higher values. 

Clearing Conditional Formats 

Getting rid of a conditional format is even more straightforward than creating it. 

All you need to do is select a cell that contains the format you want to delete, and 

follow the directions below to get of some or all of your conditional formats. 

To clear one or more conditional formats: 

1. If you want to remove a conditional format from a range of cells, select those 

cells. 

2.  On the Home tab of the Ribbon, in the Styles group, click Conditional 

Formatting. 

3.  Point to Clear Rules. 

4.  Click the desired clearing operation. 

Scenario Tasks 

The majority of your business intelligence analysis work will focus on operational 

data you’ve collected. The data you capture helps you evaluate your current 

processes. If your job requires you to estimate future costs or revenues and 

present those estimates to your fellow decision-makers, you should know about 

scenarios. 

In Excel, a scenario is an alternative set of data that Excel maintains as part of a 

workbook file. When you create a scenario, you can identify up to 32 cells on a 

worksheet and record one alternative value for each cell. You can create multiple 
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scenarios if you want to record more than one alternative for a cell, or if you want 

to define alternative values for cells on more than one worksheet. 

In this section, you will learn how to: 

• Create a scenario. 

• Edit a scenario. 

• Summarize scenarios. 

• Delete a scenario. 

Be Careful! 

Be sure to read the Scenario Gotchas sidebar at the end of this section for 

important information about working with scenarios. 

Creating a Scenario 

When you’re ready to define an alternative data set for a worksheet, display the 

Data tab of the Ribbon and then, in the Data Tools group, click the What-If Analysis 

button, and click Scenario Manager to display the Scenario Manager dialog box. 

 

From within the Scenario Manager dialog box, click the Add button to display the 

Add Scenario dialog box. 
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Type a name for the scenario, select the cells for which you want to enter 

alternate values, and click OK. Enter the new values in the Add Values dialog box, 

and click OK to record the scenario. 

To create a scenario: 

1. Display the worksheet that contains the cells for which you want to define an 

alternative data set. 

2.  On the Data tab of the Ribbon, in the Data Tools group, click the What-If 

Analysis button, and then click Scenario Manager. 

3.  Click Add. 

4.  In the Scenario Name box, type a name for the scenario. 

5.  Click in the Changing Cells box, and then, in the worksheet, select the cells 

you want to change. 

6.  Click OK to display the Scenario Values dialog box. 
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7. In the Scenario Values dialog box, type the replacement values for the cells 

you selected. 

8. Click OK to close the Scenario Values dialog box, and click Close to close the 

Scenario Manager dialog box. 

Editing a Scenario 

If you want to change an existing scenario, perhaps to add or remove cells or to 

change the replacement values, you can do so quickly from within the Scenario 

Manager dialog box. 

To edit a scenario: 

1. Display the worksheet that contains the cells for which you want to define an 

alternative data set. 

2. On the Data tab of the Ribbon, in the Data Tools group, click the What-If 

Analysis button, and then click Scenario Manager. 

3. Click the scenario you want to edit. 

4. Click Edit. 

5. Use the controls in the Edit Scenario dialog box to edit your scenario’s name 

and the cells to which it refers. 

6. Click OK. 

7. In the Scenario Values dialog box, type the replacement values for the cells 

you selected. 
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8. Click OK to close the Scenario Values dialog box, and click Close to close the 

Scenario Manager dialog box. 

Summarizing All Scenarios on a Worksheet 

When you define multiple scenarios for a worksheet, it can be difficult to keep 

track of which scenarios change which data. Rather than rely on paper and pencil, 

you can have Excel 2007 create a Scenario Summary sheet that lists all of the 

scenarios, changing cells, original values, and new values for a worksheet. 

 

Make sure your worksheet displays its original values when you create the 

Scenario Summary worksheet. If you have a scenario applied when you create the 

summary, Excel will record the replacement values as the originals and the Undo a 

Scenario and Undo All Scenarios on a Worksheet operations built into the Excel 

Presentation Kit will place incorrect data into your workbook. 
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To summarize all scenarios on a worksheet: 

1. Display the worksheet that contains the scenarios you want to summarize. 

2. On the Data tab of the Ribbon, in the Data Tools group, click the What-If 

Analysis button, and then click Scenario Manager. 

3. Click Summary. 

4. Verify that the Scenario Summary option is selected, and click OK. 

Deleting a Scenario 

If you’ve decided that you will never need to use a scenario again, you can 

delete it with a few mouse clicks. 

To delete a scenario: 

1. Display the worksheet that contains the scenario you want to delete. 

2. On the Data tab of the Ribbon, in the Data Tools group, click the What-If 

Analysis button, and then click Scenario Manager. 

3. Click the scenario you want to delete. 

4. Click Delete. 

5. Click Close to close the Scenario Manager dialog box. 

Scenario Gotchas 

Scenarios are a valuable tool when you perform what-if analysis on your data, 

but they do have a few drawbacks you should consider. The first potential problem 

is that if you save and close a workbook with one or more scenarios applied, Excel 

overwrites the original data with that of the scenario. You should consider creating 

a scenario named Normal which contains the original values in every cell changed 

by a scenario. Scenarios can contain a maximum of 32 changing cells, so you might 

need to create more than one scenario to “back up” the values of every changing 

cell. 

You should also be aware that the only way to remove a scenario after it’s been 

applied is to click the Undo button on the Quick Access Toolbar (or click Ctrl+Z). 
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The Excel Presentation Kit’s routines to remove a scenario or remove all scenarios 

add those capabilities, but you must be certain that you’ve created a Scenario 

Summary worksheet for each worksheet for which you’ve defined scenarios. 

As always, the best way to protect your data is to back up your Excel workbooks 

regularly. 

PivotTable Tasks 

PivotTables, which enable you to rearrange your worksheet data dynamically, 

are a powerful data presentation and analysis tool. In this section, you will learn 

how to:  

• Create a PivotTable 

• Pivot a PivotTable 

• Filter a PivotTable 

• Define PivotTable Conditional Formats 

Creating a PivotTable 

As the name implies, PivotTables summarize data arranged in tabular form. In 

Excel 2003 and earlier versions, you had to create a PivotTable from a data list. 

 

Data lists are limited in that a PivotTable created from the list wouldn’t display 

new data added to the list unless you dug into the PivotTable’s settings and 
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changed the data source to reflect the addition. In Excel 2007, you can (and 

should) define your data list as an Excel Table and create your PivotTable from that.  

When you add rows or columns to an Excel Table, you can update the PivotTable 

by clicking any cell in the PivotTable, clicking the Options contextual tab on the 

Ribbon, and then, in the Data group, click Refresh. 

Please Note 

You can still create a PivotTable from a data list in Excel 2007, but Excel 

Tables provide so much more functionality that there’s no reason not to use 

them. 

To create a PivotTable: 

1. Click any cell in the Excel Table from which you want to create a PivotTable. 

2. On the Insert tab of the Ribbon, in the Tables group, click PivotTable. 

3. In the Create PivotTable dialog box, verify that the table you selected 

appears in the Table/Range box, and that the New Worksheet option is 

selected. 

4. Click OK. 

5. In the PivotTable Field List task pane, drag the fields from the Choose Fields 

to Add to Report section to the desired areas in the Drag Fields Between 

Areas Below section.  

Pivoting a PivotTable 

PivotTables enable you to define more than a single, static view of your data; 

they empower you to rearrange your data dynamically so you can discover 

important facts and trends to aid process analysis and planning.  

The PivotTable in the following graphic shows data organized by month and 

year. In the PivotTable Field List task pane, notice that the Year field is in the 

Column Labels area and that the Month field is in the Row Labels area. 



 

curt@thatexcelguy.com 28 
 

 

Dragging the Year field’s header above the Month header shows all of the data 

for the months in the first year, and then moves on to the second year. 
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Experiment with various PivotTable arrangements to find the layouts that 

illustrate your points most effectively. 

To pivot a PivotTable: 

• Drag a field to a new area in the layout. 

• Drag a field to a new position within an area. 

Filtering a PivotTable 

Just as you can focus on specific data contained in an Excel Table, you can limit 

the data displayed in a PivotTable by creating a filter. The processes for creating 

PivotTable filters are identical to those for Excel Table filters. 

To filter a PivotTable: 

1. In the PivotTable Field List task pane’s Choose Fields to Add to Report 

area, hover the mouse pointer over the field by which you want to filter the 

PivotTable, and click the down arrow that appears at the far right edge of the 

field’s name bar. 

2. Use the controls in the menu that appears to define your filter. 

Defining PivotTable Conditional Formats 

Excel 2007 introduced the ability to apply conditional formats to PivotTable cells, 

which greatly enhances the program’s power as a business intelligence presentation 

tool. You use the same techniques to create a conditional format for a PivotTable as 

you do for a regular cell range; the only difference is in how you apply the format 

to the PivotTable’s contents. 

When you apply a conditional format to a PivotTable cell, a Formatting Options 

smart tag appears. Clicking the Formatting Options button displays three choices 

for how you can format the PivotTable’s cells. 
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Clicking the Selected Cells option, as the name implies, formats just the selected 

cells. Clicking the All Cells Showing “Sum of <field1>” Values option formats every 

data cell, including summary cells in subtotal and grand total columns and rows. 

Selecting this option doesn’t result in a useful conditional format because the Grand 

Total row and column values are much larger than the values in the body of the 

data area. 

 

Clicking the All Cells Showing “Sum of <field1>” Values for “<fields…>” option 

formats every data cell in the body of the PivotTable except for cells in summary 

rows. 
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When you record a PivotTable conditional format for your Excel Presentation, 

you format a single cell and the Excel Presentation Kit applies the conditional 

format using the third option (which excludes any summary rows and columns). 

To define a PivotTable conditional format: 

1. Click any cell in the PivotTable. 

2. On the Home tab of the Ribbon, in the Styles group, click Conditional 

Formatting. 

3. Create the conditional format you want to create. 

4. Click the Formatting Options smart tag that appears beside the active cell. 

5. Click the option representing the group cells to which you want to apply the 

conditional format. 

  



 

curt@thatexcelguy.com 32 
 

3 

Recording Excel Presentation 

Positions 

Positions are the basic building blocks of any Excel Presentation. Each position 

represents a workbook state that you preserve and later recreate as part of your 

presentation. After you arrange and format the data in your workbook to create the 

look you want to save, you can record the position and recall it at any time. 

In this chapter, you will learn how to: 

• Find the Record Positions item on the Ribbon 

• Prepare the Quick Access Toolbar 

• Record workbook views 

• Record Excel Table positions 

• Record scenario positions 

• Record conditional format positions 

• Record PivotTable positions 

Finding the Record Positions Item on the Ribbon 

When you open the Excel Presentation Kit workbook and allow the workbook to 

run the macros it contains, the workbook’s code adds two menus named Record 

Positions and Control Presentation to the Add-Ins tab of the Ribbon. You’ll find 

those menus in the Add-Ins tab’s Menu Commands group. 
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Clicking the Record Positions menu displays items representing the types of 

positions you can record. 

 

You can go through the Add-Ins tab of the Ribbon to record positions and 

control your presentation, but you’ll find it’s much easier to record positions and 

move through your presentation by adding buttons that run the Excel Presentation 

Kit’s macros to the Quick Access Toolbar. 
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Preparing the Quick Access Toolbar 

The Excel Presentation Kit’s custom macros extend the native capabilities of 

Excel 2007 to enable you to communicate your business intelligence analysis 

results without leaving Excel.  

You should add the following four items to the Quick Access Toolbar: 

• A button representing the PreviousStep macro 

• A button representing the NextStep macro 

• A button representing the ListPositions macro 

• A button representing the Menu Commands group on the Add-Ins tab of 

the Ribbon 

The tasks in this section show you how to add your macros to the Quick Access 

Toolbar, which enables you to move through your presentation efficiently. 

Adding a Macro to the Quick Access Toolbar 

There is a long, convoluted method of running Excel macros using the standard 

Ribbon controls, but it’s much easier to add a button representing the macro to the 

Quick Access Toolbar. When you click the button, Excel runs the macro 

immediately. 

To add a macro to the Quick Access Toolbar: 

1. Right-click anywhere on the Quick Access Toolbar, and then click 

Customize Quick Access Toolbar. 

2.  On the Excel Options dialog box’s Customize page, click the Choose 

Commands From field’s down arrow and then click Macros. 
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3. Click the macro you want to add to the Quick Access Toolbar. 

4. Click Add and then click OK. 

Adding a Ribbon Group to the Quick Access Toolbar 

Just as you can add a button to the Quick Access Toolbar, you can represent all 

of the controls in a Ribbon group as a button on the Quick Access Toolbar. Rather 

than waste clicks going to a new Ribbon tab, locating the target group, and clicking 

the desired control you can add the group to the Quick Access Toolbar, click the 

group’s button, and find the controls far more quickly. 

To add a group to the Quick Access Toolbar: 

1. On the Ribbon, display the tab that contains the group you want to add to 

the Quick Access Toolbar. 

2. Right-click the name bar of the Ribbon group you want to add. 
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3. Click Add to Quick Access Toolbar. 

Changing the Appearance of a Quick Access Toolbar Button 

Every button you can add to the Quick Access Toolbar comes with an assigned 

button image. The default images assigned to the macro buttons you add to move 

forward and backward through your Excel Presentation indicate that the buttons 

trigger a macro, but it doesn’t tell you anything about what the macro does. 

 

The button image collections contains two perfect images for the PreviousStep 

and NextStep macros: a left-pointing blue arrow and right-pointing blue arrow, 

respectively. 

 

Please Note 

You can’t change the Quick Access Toolbar button assigned to a Ribbon 

group. 

To change the appearance of a Quick Access Toolbar button: 

1. Right-click any spot on the Quick Access Toolbar. 

2. Click Customize Quick Access Toolbar. 

3. On the Customize page of the Excel Options dialog box, in the panel that 

lists the buttons on the Quick Access Toolbar, click the button you want to 

change. 

4. Click Modify. 
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5. In the Modify Button dialog box, click the button image you want to assign 

to the macro button. 

6. Click OK. 

Reordering Buttons on the Quick Access Toolbar 

As you continue to work with Excel 2007 and the Excel Presentation Kit, you’ll 

most likely find that you use some Quick Access Toolbar buttons more frequently 

than others and that some button positions make it easier for you to manipulate 

your workbooks quickly. By changing the order in which buttons appear, you can 

configure the Quick Access Toolbar to streamline your workflow. 

To reorder buttons on the Quick Access Toolbar: 

1. Right-click any spot on the Quick Access Toolbar. 

2. Click Customize Quick Access Toolbar. 

3. On the Customize page of the Excel Options dialog box, in the panel that 

lists the buttons on the Quick Access Toolbar, click the button you want to 

move. 

4. Click the Move Up or Move Down button. 

5. Click OK. 
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Removing a Button from the Quick Access Toolbar 

Adding a button to the Quick Access Toolbar isn’t a one-way operation. You can 

remove a button with two mouse clicks. 

To remove a button from the Quick Access Toolbar: 

1. Right-click the button. 

2. Click Remove from the Quick Access Toolbar. 

Displaying the Quick Access Toolbar Under the Ribbon 

If you add a lot of buttons to the Quick Access Toolbar, the toolbar’s contents 

might crowd the file name and other information at the top of the program window. 

You can display the Quick Access Toolbar under the Ribbon to give yourself more 

room to add buttons. 

To display the Quick Access Toolbar under the Ribbon: 

1. Right-click any spot on the Quick Access Toolbar. 

2. Click Show the Quick Access Toolbar Below the Ribbon. 

 

Recording Workbook Views 

One of the most basic operations you can perform during an Excel Presentation 

is to display a worksheet. As simple as that operation is, it can be difficult to 

remember which worksheet you wanted to display when you’re in the middle of 

discussing the data contained on another worksheet! Creating a Show Worksheet 

position makes the transition more certain.  
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A Saved View position offers a little more control over your workbook than Show 

Worksheet positions do. Rather than just display a worksheet, the Saved View 

position records the cell at the top-left corner of the Excel window and remembers 

the worksheet’s magnification, or zoom level, so you can make the worksheet’s 

contents larger or smaller as desired. 

In this section, you’ll learn how to: 

• Record a Show Worksheet position 

• Record a Saved View position 

Recording a Show Worksheet Position 

Excel workbooks can contain two types of sheets: worksheets, which can contain 

data, graphics, and charts; and chart sheets, which contain a single chart that is 

the only item on the sheet. However, most users refer to both types of sheets as 

worksheets, so I used the familiar term in naming this type of position. 

When you want to show a worksheet as part of your Excel Presentation, display 

the custom Ribbon group created by the Excel Presentation Kit, click Record 

Positions, and click the Show a Worksheet item.  In the dialog boxes that appear, 

type the name of the position and then the name of the worksheet you want to 

display. When you click OK in the second dialog box, the Excel Presentation Kit 

records the position for later recall. 

Please Note 

All of the other Excel Presentation Kit positions record the worksheet 

referenced by the position, so you don’t need to record a Show Worksheet 

position to get to the proper place in your workbook.  

To record a Show Worksheet Position: 

1. Display the worksheet you want the saved position to show. 

2. On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

3. Click Record Positions, and then click Show a Worksheet. 
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4. In the dialog box that appears, type the name of the position, and click OK. 

5. In the dialog box that appears, type the name of the worksheet you want to 

display, and click OK. 

Recording a Saved View Position 

Like a Show Worksheet position, a Saved View position displays a worksheet. 

Unlike the Show Worksheet position, though, a Saved View position also records 

the address of the first cell that is visible at the top left corner of the screen and the 

worksheet’s zoom level. In the worksheet below, the first visible cell is B2, and the 

worksheet’s zoom level is 160%. 

 

When you’re ready to record a Saved View position, display the custom Ribbon 

group  created by the Excel Presentation Kit, click Record Positions, and click the 
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Record a View item. Just type the name of the Saved View in the dialog box that 

appears and you’re done! 

To record a Saved View Position: 

1. Show the worksheet with the displayed cells and zoom level you want to 

record. 

2.  On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

3.  Click Record Positions, and then click Record a View. 

4.  In the dialog box that appears, type the name of the position, and click OK. 

Recording Excel Table Positions 

Excel Tables, which are new in Excel 2007, enable you to store your data 

effectively. You can also limit the data that appears in a table by applying filters. 

In this section, you’ll learn how to: 

• Record a Table Filter (by selection or rule) position 

• Record an Above or Below Average table filter 

• Record a Top or Bottom 10 table filter 

• Record a Clear All Table Filters on a Worksheet position 

Recording a Table Filter Position 

Excel Tables typically contain hundreds or thousands of rows of data. To 

examine the table’s data effectively, you will often need to limit the data displayed 

in the table by applying a filter. Excel 2007 enables you to create two types of table 

filters: a selection filter, and a rule-based filter.  

As the name implies, a selection filter lets you select the items to be displayed. 

To create a selection filter, you click a column’s filter arrow and select the items you 

want to appear when the filter’s applied. A rule-based filter, by contrast, uses an 

operation (such as greater than or between) and one or two arguments (values 

used to set the rule’s parameters).  



 

curt@thatexcelguy.com 42 
 

 

 

Important 

Because of the way Excel 2007 records a selection filter’s parameters, you 

may only record selection filters with one or two items selected. 

You can create the following rule-based filters in Excel 2007: greater than, less 

than, greater than or equal to, less than or equal to, equals, does not equal, 

between, and not between. You can create two other types of filters, Above or 

Below Average and Top or Bottom 10 filters, but you save them using operations 

described later in this section. 

To record a Table Filter Position: 

1. Create the table filter you want to record. 

2.  On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

3.  Click Record Positions, and then click Record a Table Filter. 

4.  Read the warning in the message box that appears, and click OK. 

5.  Type a name for the position, and click OK. 
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Recording an Above or Below Average Table Filter 

When you want to present a view highlighting data that falls above or below the 

average value in a table column, define and save an Above or Below Average Table 

Filter. 

To record an Above or Below Average Table Filter position: 

1. Create the table filter you want to record. 

2.  On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

3.  Click Record Positions, and then click Record an Above or Below 

Average Table Filter. 

4.  Type a name for the position, and click OK. 

Recording a Top or Bottom 10 Table Filter 

Top or Bottom 10 Table Filters enable you to display the table rows that contain 

the highest or lowest values in a column. You can define an exact number of rows 

to display, such as the top 3 sales days of the month, or define a percentage of 

rows to display, such as the bottom 5% of a medical school’s graduating class.  

To record a Top or Bottom 10 Table Filter position: 

1. Create the table filter you want to record. 

2.  On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

3.  Click Record Positions, and then click Record a Top or Bottom 10 Table 

Filter. 

4.  Type a name for the position, and click OK. 

Recording a Clear All Table Filters on a Worksheet Position 

When you’re ready to display all of the data in a worksheet’s tables, you can 

record a Clear All Table Filters on a Worksheet position to restore the worksheet’s 

tables to their unfiltered state. 
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To record a Clear All Table Filters on a Worksheet Position: 

1. On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

2.  Click Record Positions, and then click Clear All Table Filters on a Sheet. 

3.  In the dialog box that appears, type the name of the position, and click OK. 

4.  In the dialog box that appears, type the name of the worksheet that contains 

the table with the filters you want to clear, and click OK.  

Recording Scenario Positions 

Scenarios store alternative data sets you can call up to examine your 

enterprise’s performance under different conditions. As useful as they are, 

scenarios take several mouse clicks to apply, affecting your flow and dividing your 

attention as you give your presentation. The Excel Presentation Kit lets you apply 

and remove scenarios, each with a single mouse click, so you can concentrate on 

your message. 

In this section, you will learn how to: 

• Record an Apply Scenario position 

• Record an Undo a Scenario position 

• Record an Undo All Scenarios position 

Recording an Apply Scenario Position 

After you define scenarios for a worksheet, you can apply any of those scenarios 

by recording an Apply Scenario position. The Apply Scenario macro doesn’t record 

the scenario’s positions on the Positions worksheet. Instead, the routine records the 

name of the scenario (and the worksheet to which it applies) and instructs Excel to 

apply the scenario to the worksheet during your presentation. 

To record an Apply Scenario Position: 

1. Display the worksheet with the scenario you want to show. 
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2.  On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

3.  Click Record Positions, and then click Record a Scenario. 

4.  In the dialog box that appears, type the name of the position, and click OK. 

5.  In the dialog box that appears, type the name of the scenario you want the 

position to display, and click OK. 

Recording an Undo a Scenario Position 

When you’re done analyzing alternative data set contained in a scenario, you 

can use an Undo a Scenario position to restore the worksheet’s original data. For 

the Undo a Scenario macro to work, you must create a summary worksheet for the 

sheet that contains the scenario you want to undo.  

Before you summarize a worksheet’s scenarios, be sure the worksheet has no 

scenarios applied to it! If you create a scenario summary worksheet while a sheet 

has a scenario applied, the scenario summary worksheet will have incorrect values 

in the Current Values column. 

Consider this… 

It might be a good idea to create a scenario named OriginalValues, which 

contains the starting values for each cell you change in a scenario. Scenarios 

can record the contents of up to 32 cells, so you should have plenty of space 

to store your worksheet’s original data. If not, just create another scenario to 

record the excess. 

To record an Undo a Scenario Position: 

1. Display the worksheet with the scenario you want to hide. 

2.  On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

3.  Click Record Positions, and then click Undo a Scenario. 

4.  In the dialog box that appears, type the name of the position, and click OK. 
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5.  In the dialog box that appears, type the name of the scenario you want the 

position to hide, and click OK. 

6.  In the dialog box that appears, type the name of the worksheet that 

summarizes the scenarios on the target worksheet, and click OK. 

Recording an Undo All Scenarios Position 

If you’ve applied more than one scenario to a worksheet, you can remove all of 

those changes in one go by recording an Undo All Scenarios position. Each Undo All 

Scenarios position affects a single worksheet; to begin recording this type of 

position, display the worksheet you want to restore, open the Record Positions 

custom menu, and select Undo All Scenarios 

Important 

For the Undo All Scenarios macro to work correctly, you must create a 

scenario summary worksheet for the worksheet that contains the scenarios 

you want to undo. Just like when you record an Undo a Scenario position, be 

sure your worksheet contains its original values so the summary correctly 

reflects both the original values and your changes. 

To record an Undo All Scenarios Position: 

1. Display the worksheet with the scenarios you want to hide. 

2.  On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

3.  Click Record Positions, and then click Undo All Scenarios. 

4. In the dialog box that appears, type the name of the position and click OK. 

5.  In the dialog box that appears, type the name of the worksheet that 

summarizes the scenarios on the target worksheet and then click OK.  

Recording Conditional Format Positions 

All of the routines that record a conditional format require that you apply the 

desired conditional format to a cell on the same worksheet as the range you want 
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to format as part of your Excel Presentation. Rather than attempt the to record 

every possible element of a conditional format, the Excel Presentation Kit copies the 

format from the sample cell you create and pastes it into the appropriate table on 

the Positions worksheet .  

 

When you reach a conditional format position comes up during your Excel 

Presentation, the Excel Presentation Kit’s macros copy the conditional format you 

recorded onto the range of cells you selected when you recorded the position. 

In this section, you will learn how to: 

• Record an Apply Conditional Format to a Range position 

• Record a Clear All Conditional Formats from a Range position 

• Record a Clear All Conditional Formats on a Worksheet position 

Recording an Apply Conditional Format to a Range Position 

When you’re ready to record an Apply Conditional Format to a Range position, 

define the conditional format in a cell on the same worksheet as the range you 

want to format during your Excel Presentation. The formatted cell can, but doesn’t 

have to be, part of the range to be affected during the Excel Presentation.  

Be sure to test the conditional format you create by typing several values into 

the cell where you define the format. 

To record an Apply Conditional Format to a Range Position: 

1. On the worksheet that contains the range you want this position to affect, 

format a cell with the conditional format you want to apply to the range. 

2.  On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

3.  Click Record Positions, and then click Apply CF to a Range. 

4.  In the dialog box that appears, type the name of the position, and click OK. 
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5.  Select the cells to which you want to apply the conditional format, and click 

OK. 

6.  Select the cell that contains the conditional format you want to apply to the 

range, and click OK. 

Recording a Clear All Conditional Formats from a Range 

Position 

Conditional formats can help illustrate the relationships among the data in a 

range, but the colors can also distract your viewers from the underlying values. 

When you’re done making a point using conditional formats, you can record a 

position to remove those formats from the affected range. 

To record a Clear All Conditional Formats from a Range Position: 

1. Display the worksheet that contains the range from which you want to 

remove all conditional formats. 

2.  On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

3.  Click Record Positions, and then click Clear a CF from a Range. 

4.  In the dialog box that appears, type the name of the position, and click OK. 

5.  Select the cells from which you want to remove all conditional formats, and 

click OK. 

Recording a Clear All Conditional Formats on a Worksheet 

Position 

Just as you can remove all conditional formats from a range, you can also clear 

all conditional formats from a worksheet. All you need to do is run the Clear All 

Conditional Formats on a Sheet macro and select the worksheet you want to clear! 

To record a Clear All Conditional Formats on a Worksheet Position: 

1. On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 
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2.  Click Record Positions, and then click Clear All Conditional Formats on a 

Sheet. 

3.  In the dialog box that appears, type the name of the position, and click OK. 

4.  In the dialog box that appears, type the name of the worksheet from which 

you want to clear all conditional formats, and click OK. 

Recording PivotTable Positions 

If you’ve used PivotTables to display data as part of a sales or marketing 

presentation, you’ve probably written down the PivotTable’s field arrangement so 

you could reconstruct a configuration that helped you illustrate a particular point. 

 

The Excel Presentation Kit enables you to record PivotTable arrangements so 

you can make your points immediately, without having to look up your PivotTable 

field orders on a piece of paper and apply the settings by hand. 

In this section, you will learn how to: 

• Record a PivotTable Position 

• Record a PivotTable Filter by Rule position 

• Record a PivotTable Selection Filter position 

• Record an Undo PivotTable Field Filter position 

• Record a Clear All PivotTable Filters position 

• Record a PivotTable Conditional Format position 

• Record a PivotTable Conditional Format Clearing position 
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Recording a PivotTable Position 

When you’re ready to record a PivotTable position, arrange the PivotTable fields 

to highlight the data and run the Record PivotTable Position macro. 

To record a PivotTable Position: 

1. Arrange the PivotTable into the desired position. 

2.  On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

3.  Click Record Positions, and then click Record PivotTable Position. 

4.  In the dialog box that appears, type the name of the position, and click OK. 

Recording a PivotTable Filter by Rule Position 

Excel 2007 PivotTables summarize data collections stored in Excel Tables, SQL 

Server database tables, and large data collections. Just as you can emphasize a 

point by filtering the data displayed in an Excel Table, you can use a filter to limit 

the data displayed in a PivotTable. 

PivotTable filters are stored differently than Excel Table filters, so you can record 

either a rule-based filter or a selection filter. When you’re ready to record a rule-

based filter, which apply the filter and record the position by invoking the Record 

Rule-Based PT Filter macro. 

To record a PivotTable Filter by Rule Position: 

1. Apply a rule-based filter to a field in the target PivotTable. 

2.  On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

3.  Click Record Positions, and then click Record Rule-Based PT Filter. 

4.  In the dialog box that appears, type the name of the position, and click OK. 

5.  In the dialog box that appears, type the name of the field you want to filter, 

and click OK. 
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Recording a PivotTable Selection Filter Position 

Just as you can create a rule-based filter, which finds all values that meet a 

given criteria (e.g., “all days with attendance below 1400”), you can select values 

from the list of available values that appear when you click a field’s filter arrow. 

 

To record a PivotTable Selection Filter Position: 

1. Apply a selection filter to a field in the target PivotTable. 

2.  On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

3.  Click Record Positions, and then click Clear a PT Field Filter. 

4.  In the dialog box that appears, type the name of the position, and click OK. 

Recording an Undo PivotTable Field Filter Position 

Regardless of whether you apply a rule-based filter or selection filter to a 

PivotTable field, you can remove the filter from that field by recording an Undo 

PivotTable Field Filter position.  
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To record an Undo PivotTable Field Filter Position: 

1. Click any cell in a PivotTable that has a filter applied to one of its fields. 

2.  On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

3.  Click Record Positions, and then click Clear a PT Field Filter. 

4.  In the dialog box that appears, type the name of the position, and click OK. 

5.  In the dialog box that appears, type the name of the field from which you 

want to remove the filter, and click OK. 

Recording a Clear All PivotTable Filters Position 

If you’ve applied filters to more than one PivotTable field and want to restore 

the PivotTable to its unfiltered state, you don’t need to undo the filters one by one. 

Instead, you should record a single Clear All PivotTable Filters position to reset your 

PivotTable. 

To record a Clear All PivotTable Filters Position: 

1. Click any cell in a PivotTable that has a filter applied to one or more of its 

fields. 

2.  On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

3.  Click Record Positions, and then click Clear All PT Filters. 

4.  In the dialog box that appears, type the name of the position, and click OK. 

Recording a PivotTable Conditional Format Position 

In Excel versions prior to Excel 2007, it wasn’t possible to apply a conditional 

format to the cells in a PivotTable. By introducing that ability in Excel 2007, the 

Excel product team greatly enhanced your ability to summarize worksheet data 

visually. Rather than requiring you to copy and paste your PivotTable data into 

another worksheet, or transform a PivotTable into a range, you can apply a wide 



 

curt@thatexcelguy.com 53 
 

variety of conditional formats directly to your PivotTables and have the conditional 

formats change as the data arrangements change. 

To record a PivotTable Conditional Format Position: 

1. Apply a conditional format to any cell in the data area of a PivotTable, and 

leave that cell selected. 

2. On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

3. Click Record Positions, and then click Record PT Conditional Format. 

4. In the dialog box that appears, type the name of the position, and click OK. 

Recording a PivotTable Conditional Format Clearing Position 

When you’re ready to remove all conditional formats from a PivotTable, click any 

cell in that PivotTable and follow the steps below to record a PivotTable Conditional 

Format Clearing position. 

To record a PivotTable Conditional Format Clearing Position: 

1. Click any cell in a PivotTable that has a conditional format applied to it. 

2.  On the Quick Access Toolbar, click the button representing the Menu 

Commands group. 

3.  Click Record Positions, and then click Clear All PT Conditional Formats. 

4.  In the dialog box that appears, type the name of the position, and click OK. 
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4 

Building Excel Presentations 

Combining the positions you record into an Excel Presentation represents the 

last step you take before you rehearse and deliver your message. The Excel 

Presentation Kit’s control panel enables you to add, remove, reorder, and print a 

list of positions (a cue list) that takes the guesswork out of your transitions and 

enables you to focus on the points you want to make. 

In this chapter, you will: 

• View a sample Excel Presentation 

• Manage Excel Presentations 

• Prepare the Quick Access Toolbar 

• Deliver an Excel Presentation 

Viewing a Sample Excel Presentation 

Here’s what a very simple Excel Presentation might look like. I’ve included a 

sample script and captured a screen shot for each of the presentation’s seven steps 

to give you a context for how the Excel Presentation Kit can streamline your talks. 

Thanks for coming. I’d like to review our sales figures for 2008, 2009, and 2010.  
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Here are each month’s sales for the last three years. Note that in 2008, we had 

below average sales in October, November, and December. The next position 

compares the three years’ data more directly. 

 

As you can see, our sales total dropped in 2009, but rebounded significantly in 

2010. However, if we focus on the year 2009, you’ll see that the month of March 

stood out because of the national bid we won. 
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The next year, we won three such bids: one in May, one in November, and one 

in December. 

 

Similar high sales months in 2008 (January, April, May, and June) were due in 

large part to companies spending money at the beginning of their fiscal year or in 

the second quarter due to significant increases in their own business. 
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I’ll add some color to the data so you can more easily see how the months 

compare. April, May, and June are consistently our best sales months on average; 

August is consistently our worst. 

 

I’ll just clear the formatting to leave the PivotTable data on its own. 
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Thanks again for coming. I’ll be glad to answer any questions you might have. 

Managing Excel Presentations 

I’ve tried to make the mechanics of combining saved positions into a worksheet 

as simple as possible so you can get up and running with the Excel Presentation Kit 

right away.  

In this section, you will learn how to: 

• Create a new Excel Presentation workbook 

• Add a cue to an Excel Presentation 

• Delete a cue from an Excel Presentation 

• Renumber and reorder Excel Presentation cues 

• Print the Excel Presentation cue list 

Creating a New Excel Presentation Workbook 

After you copy the EPK_Template workbook to your computer, you can have 

Excel 2007 create new workbooks from using it as a template. The procedure for 

creating a new workbook from a template is a few steps longer than creating a 

new, blank workbook, but it’s not a difficult task. 
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Be Careful! 

Be sure to change only the file you create from the EPK_Template workbook. 

Changing the EPK_Template file itself means that every edit will appear in 

every workbook you create from the template.  

Even though the EPK_Template workbook is a macro-enabled template, Excel 

offers to save the file you create using the template as a standard Excel 2007 

workbook (*.xlsx). You’ll need to change the saved file’s type to Excel Macro-

Enabled Workbook (*.xlsm) for the Excel Presentation Kit’s macros to work. 

To create a new Excel Presentation workbook from the EPK_Template.xltm 

template file: 

1. Click the Office Button, and then click New. 

2. In the New Workbook button, in the Templates section, click New From 

Existing. 

3. In the New from Existing Workbook dialog box, navigate to the folder that 

contains the EPK_Template.xltm workbook. 

4. Click the workbook, and then click Create New. 

5. Click the Office Button, and then click Save As. 

6. In the Save As dialog box, navigate to the directory where you want to save 

the Excel Presentation workbook. 

7. In the File Name field, type a name for the Excel Presentation workbook. 

8. Click the Save as Type field’s down arrow, and then click Excel Macro-

Enabled Workbook (*.xlsm). 

9. Click Save. 

Adding a Cue to an Excel Presentation 

When you’ve saved the positions you want to be part of your Excel Presentation, 

you can begin adding those positions to your cue list. You add positions to your 

presentation by adding rows to the ControlPanel table, found on the Control 

worksheet. 
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The ControlPanel table contains four columns: 

• Cue, which contains position numbers. 

• Type, which allows you to select the type of position to add to the 

presentation. 

• Position Name, which contains the name of the position to add. 

• Description, which contains a brief summary of the position. 

Don’t overlook the importance of adding a description for each position. Even if 

you print out your cue list, which you should do as a matter of course, the 

position’s name might not jog your memory. 

Be Careful! 

The list of available position types appears in the AvailableActions table, 

which is stored in the Control worksheet’s column H. The Excel Presentation 

Kit’s macros expect the Type column’s cells to contain one of the nineteen 

pre-defined position types. Feel free to take a look if you must, but please 

don’t change anything! 

To add an Excel Presentation cue: 

1. Display the Control worksheet. 

2. In the first blank cell in the Cue column of the Control Panel table, type a 

number that is ten greater than the number in the cell above it. 

3.  In the same row, click the cell in the Type column, click the down arrow that 

appears, and select the type of position you want to add to the presentation. 
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4.  In the same row, in the Position column, type the name of the position you 

want this cue to display. You may also click the ListPositions macro button on 

the Quick Access Toolbar and then copy the desired position name from the 

Selection Items list displayed in column F of the Control worksheet. 

5.  Type a summary of the position the same row’s Description column. 

6. Press the Tab key to start a new table row. 

A Cue Numbering Trick  

You probably noticed that the first cue in the ControlPanel table is numbered 10 

instead of 1. It’s not an oversight. You should number the first cue 10, the second 

20, and so on. Here’s why. 

When the computerized boards that control the lights in a theater were in their 

early stages of development, you ran a great risk of having to re-do a lot of work if 

you missed adding a cue to your program. For example, if you add cues 1-99 and 

realize you missed out cue number 4, you’d have to renumber or (more likely) 

recreate the cues that are now numbered 5-100.  

Subsequent light boards enabled you to create what were called point cues, 

which meant you could create cue 3.5 to insert the lighting cue you missed without 

spending a couple of hours recording the other 96 cues again.  
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Numbering your Excel Presentation Kit cues in increments of 10 gives you plenty 

of room to add cues at the last minute without blowing away your numbering 

scheme or forcing you to add cues to the middle of the table and risk making a 

mistake and deleting a cue you wanted to keep. Just add the new cue to the 

bottom of the table, give it a number between those of the cues you want it to 

occur between, sort the table from smallest to largest by cue value, and you’re on 

your way. 

Deleting a Cue from an Excel Presentation 

Getting rid of a cue that no longer fits into your presentation is as 

straightforward as deleting the table row that contains the cue. 

To delete an Excel Presentation cue: 

1. Right-click any cell in the row that contains the cue you want to delete. 

2. Point to Delete, and then click Table Rows. 

Renumbering and Reordering Excel Presentation Cues 

As you review your Excel Presentation, you might decide to refine the order of 

positions within the presentation. Changing the order of Excel Presentation 

positions requires nothing more than editing the positions’ cue numbers and sorting 

the ControlPanel table’s rows from the lowest cue number to the highest. 

Be Careful! 

Be sure not to assign the same cue number to more than one cue. You won’t 

break the presentation, but the Excel Presentation Kit might not display the 

cues in the order you want. 

To renumber an Excel Presentation cue: 

• Edit the value in the Cue column of the cue’s row. 

To renumber all Excel Presentation cues: 

1. Renumber the cues to reflect the desired order. 

2. If necessary, in cell A2, type 10. 
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3. If necessary, in cell A3, type 20. 

4. Select the cell range A2:A3. 

5. Grab the Fill Handle at the bottom right corner of cell A3 (the mouse pointer 

changes from a white Greek cross to a black crosshairs), and drag it until the 

selected region covers the last cell in the Control Panel table’s Cue column. 

 

To sort Excel Presentation cues so the table’s order reflects the current cue 

numbers: 

1. Display the Control worksheet. 

2. In the ControlPanel table, click the Cue column’s filter arrow. 

 

3. Click Sort Smallest to Largest. 

Printing the Excel Presentation Cue List 

When I designed the Excel Presentation Kit, I wanted to keep the mechanics of 

the kit in the background so your audience can focus on your message. As the 

presenter, you must manage both your message and the technology you use to 

deliver your presentation. One good way to keep your bearings during an Excel 

Presentation is to print out your cue list. 

To print an Excel Presentation cue list: 

1. Click any cell in the ControlPanel table. 

2. Click the Office Button, and then click Print. 

3. In the Print dialog box, click the Table option button. 

 

Fill Handle
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4. Click OK. 

Delivering an Excel Presentation 

When you open a workbook created using the Excel Presentation Kit template 

file, you should find the Record Positions and Manage Presentation menus in the 

Menu Commands group on the Add-Ins tab of the Ribbon.  

Starting an Excel Presentation 

Once you’re ready to start an Excel Presentation, run the StartPresentation 

macro to display the first position in the presentation. 

To start an Excel Presentation: 

• If you haven’t added the Menu Commands group to the Quick Access 

Toolbar, display the Add-Ins tab of the Ribbon. Then, in the Menu 

Commands group, click Control Presentations and then click Start 

Presentation. 



 

curt@thatexcelguy.com 65 
 

• If you have added the Menu Commands group to the Quick Access 

Toolbar, click the button representing the group, click Control 

Presentations and then click Start Presentation. 

• If you want to use a presentation remote or move between positions by 

pressing the N or P keys, click the Quick Access Toolbar button 

representing the Menu Commands group, click Control Presentations, 

and then click Enable Control Keys. When you’re done with your 

presentation, click Disable Control Keys. 

Be Careful! 

If you have enabled control keys, typing the letter n or p will move you 

forward or backward one position! 

Displaying the Next Position 

After you’ve completed discussing the point illustrated by a position, you can 

move to the next position quickly. 

To move forward one position in an Excel Presentation: 

• If you’ve added a Quick Access Toolbar button for the NextStep macro, 

click the button. 

• If you’ve enabled the presentation control keys, press the N key or click 

the Next button on your presentation remote. 

Displaying the Previous Position 

If you realize you forgot to make a point during your discussion of a previous 

position, you can use the PreviousStep macro to revisit positions you’ve already 

displayed. 

To move back one position in an Excel Presentation: 

• If you’ve added a Quick Access Toolbar button for the PreviousStep 

macro, click the button. 

• If you’ve enabled the presentation control keys, press the P key or click 

the Previous button on your presentation remote. 
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Displaying a Specific Position 

If a member of your audience asks a question that can be best answered by 

displaying a specific position in your Excel Presentation, you can use the cue list on 

the Control worksheet to move directly to that position. The only consideration is 

that you need to select the number of the cue before the one you want to display, 

and then click the NextStep macro button. 

To display a specific position: 

1. Display the Control worksheet. 

2. Click the cell in the ControlPanel table’s Cue column above the cue you 

want to display. 

3. Display the next position by clicking the NextStep macro’s button on the 

Quick Access Toolbar. 
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